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Advance Diploma In Computer Application ™ B

Course Duration: 1 Year Limited Seats: 15 Students

Course Name Total Fees Blg Discount

DCA 40640/ - 18,001/- 21,999/-

Single Instaliment 1000 Admission Fess 20,000/- Save Rs 1000/-
3 Installment MONTHLY PAY FEES . JUST Rs. 3000/-

Note; Installment Pay Every Month Fix Date / Free C e E-Notes on Mobile App

¢  Free Course Video Lecture on Mobile App
Same Day Admission Benefits

¥  Frea English Speaking Leaming App
*  Free Resuma Writing
< Free Important Interview Question and Answer

L Rg 18001/~
. 5 - v  Practical Interview Session

L | g -r 4 l
Free English Speaking App ¥  Free Motivational Seminar

¥  Free Mind Power Seminar

ADCA Syllabus
1) Computer Fundamental

2) MS- Paint Adv, Tally Prime with GST
3) Notepad Professional Tally Prime GST

4) Word Pad Coral Draw (Optional)

5) MS-Word 2013 Photo Shop (Optional)
6) MS- Power point Computer Hardware Engineering

7) MS-Excel 2013

Computer Driver & OS Installation

Assignment & Project
8) Advance Excel 2013 Sniping Tool

9) Basic Tally prime Scanning & Printing
10) Intemet Web App Development

Certificate: Government Recognized With Online Verification Certificate
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Lecture Notes on MS Excel 2013

into rows and columns. You can also use it to perform mathematical calculations

quickly. This course teaches Microsoft Excel basics as a prelude to the use of
Statistical Analysls System (SAS) software In carrying out more complex statistical analysis.
Although knowledge of how to navigate in a Windows environment is helpful, this manual is
created for the computer novice.

M icrosoft Excel is an electronic spreadsheet. You can use it to organize your data

At the end of the course, participants are expected to know how to use Microsoft Excel to:

+ Minimum § Vears Experienca in Acsounting
<+ Salary 16 nol 8 conalant for the right candidasts

LAB TECHNICIANS / LAB ASSISTANTS

+ Diplama / IT or B.8¢ in CSE /1T 7 Phryuids | Chemisiny

Print results
Create Charts, and
Enter advanced Excel formulas

- Enter text and numbers in a spreadsheet

- Enter Excel formulas “’;‘ ‘\Tl: “
- Format data

=  Create Excel functions | Eﬂﬂiﬂfﬂ -

=  Fill cells automatically + Mnowidge in Tally & Comy

-

-

L3

Accordingly, the course is divided Into the following five (5) sections.

Section 1: Entering Text and Mumbers

Section 2: Entering Excel Formulas and Formatting Data Section
3: Creating Excel Functions, Filling Cells, and PrintingSection 4:
Creating Charts

Section 5: More on Entering Excel Formulas

Starting Excel

Start button > All Programs > Microsoft Office > Excel 2013

."Ifl.? fdit Fomat Yew Help

hlew Clil=h
The MS Excel 2013 window Open.. Ctif=0)
FILE MENU - Save Ciri+5
Sweds,
1. NEW - (CTRL+N) Open New File. i St
2. OPEN - (CTRL+0) Open your old file. Print.. CtriP
3. SAVE - (CTRL+S) Save your File. | mit
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4. SAVE AS - Save your file with new name.
5. PAGE SETUP - Setup your page for printout.
6. PRINT — (CTRL+P) Print your document.

DCA

Diploma In Computer Application

Course Duration: 6 Month  Limited Seats: 15 Students | Offer Last Date: 22 April 2022

Course Name Total Fees Big Discount
DCA 32,000/- 16,000/- 16,000/16500/-

Single Installment 500 Admission Fess 153,500/-
3 Instaliment _ 1000 + 5000/- _ 5500/- 5000/-

Mote: Installment Pay Every Month Fix Date ¥ Free Course E-Notes on Mobile App
DCA Syllabus
1) Computer Fundamental
2) MS- Paint Basic Tally prime
3) Notepad Adv. Tally Prime with GST
4) Word Pad Internet
5) MS-Word 2013 Assignment & Project

6) MS- Power point Sniping Tool
7) MS-Excel 2013 Scanning & Printing
8) Advance Excel 2013 Web App Development

Certificate: Government Recognized With Online Verification Certificate
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EXCEL : HOME TAB/

% Cut = {ctrix}
Remove the selection and put it on Clipboard so you can paste it somewhere
else.

% Copy = {ctiltc)
Put a copy of the selection on the Clipboard so you can paste it somewhere
else.

< Paste = {ctrl+V}
Add content on the Clipboard to your document.

% Format Painter
Like a look of a particular selection you can apply that look to other
content in the document.
To get started:
1. Select content with the formatting you like
2. Click Format Painter
3. Select something else to automatically apply the formatting

< Font i K S L
Pick a new font for your text. £ 1

A Tivik Emioaprive URE_EWITLF REEUIRED

Graduation / PG In Marketing Management

% Font Size PROPERTY SALES |, 7.4 years of Bxparience in Real Fstaro
; OFFICER: Sales Gruwih Dolented Aggressive Loukling
Change the size of your text. For Challenging Salos Carcer

Degree / Diploma in Civil Engireoring with
= SITE ENGINEER: | 5 tn 10 Year af Sxporieren m Handing Sitn
% Bold = {ftl'H'B} execution work independently.

= }'ﬂl]l' text bold. MECHANICAL | Degree / Diploma in Mechanical Engineers
ENGINEERS | with Hand:ing Mechanical work, Knowledge

of Afe, Bectrical, Transformer Repairing &
TECHNICIAN: |5/ P

% Ttalic = {ctrl + T}
-4 : B.Com ; Mcom with 2 to 5 Years Expericnee
ItE].lClIE }Gl]l' Text. Enowhedpe ol Tally willing tc work on puschase,

mies, RS, Car hardle Acocountz up o Tinalimtion.

“ Underline = {ctri+U]}
Underline your text.

b = K A == ¥ - E_! T T ] | P '.I!' - . N E l Ml iupy = ll"'r "'_.:
et e | D wn & FATA
oo N m B el v et 07 . & v | %y & | TrsfEnn Faes e e L L T W & Fa
Pai-da 'L' i F||||r--—|||,:l it s Sl e = Lhmay ¢ Flrpy = Eple—
Friil = ki gnem 1. % EOT L L3 Tiraa Sl FrEmy
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o Add or Remove From yvonr selection

To change the look of the borders, check out the options on the Table
Tools Design Tab or use the borders and Shading.

% Fill color
Color the background of the cells.

% A Font color
Change the color of text. | B3 sl l'.{ﬂ-’ﬂiﬁl'ﬂ

< Increase Font Size 7 Best Job |
Make your text bit bigger. r
ADVANCED
% » Decrease Font Size EXCEL
Make your text bit smaller
< — Top Align
Align text on the top

% — Middle Align
Align text so that I is centered between the top and bottom of the cell.

%* — Bottom Align
Align text on the bottom.

% ¥ Orientation
Rotate your text diagonally or vertically .This is great way to label
narrow column.

% = Align Left
Align vour content to the left.

% — Center

Center your content.
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% — Align Right
Align vour content to the right.

< = Decrease Indent
Move your content closer to the eell border.

% 5= Increase Indent
Move your content farther away from the cell border,

% 5 Wrap Text
Wrap extra-long text into multiple lines so you ¢an see all on 1.

% [& Merge & Center
Combines and center the contents of the selected cells in a new large
cell.
This is a great way to create a label that spans multiple column.

A Number Format
_ zeEneral .

Choose the format for your cells. such as percentage. currency, date or
time.

%

L J

> Accounting Number Format
Format as dollars. Euros, or other Currency.

< % Percent Style {Ctr1+Shift+%)
Format as a percent.

% + Comma Style
Format with a thousands separator.

[lg 2 Month  COOO /4500

< ! Increase Decimal Diplarms in Advance Exce Tie & Monin | 8000/ 8500

Show more decimal places for a more precise value.

“ !l Decrease Decimal
Show fewer decimal places.
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o |}: Conditional Formatting

Easily spot trends and patterns in your data using bars, colors, and icons
to visually highlight important values.

% ,Format as Table

Quickly convert a range of cells to a table with its own style.

“ [[ ) Cell Style

A colorful style is a great way to make important data stand out on then
sheet.

Complete Course
g Yea® Carmpusr Coutag

Eaze, AT LiFea Buky
| sww D ies, NTH T.II]T

B ;q;m Insert Cells

Add new cells, rows or columns to your workbook.
FYT: To insert multiple rows or columns at a time, select multiple rows or
columns in the sheet, and click Insert.

o Iﬂp.\ Delete Cells
Delete cells, rows, columns, or sheets from your workbook.
FYI: To delete multiple rows or columuns at a time, select multiple rows
or columns in the sheet, and click Delete.

o ‘—;‘— Format

Change the row height or column width. organize sheets, or protect or
hide cells.

< 3 Sum {Alt+=}
Automatically add it up. Your total will appear after the selected cells.
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“ ¥ Fil
Continue a series or pattern into neighboring cells in any direction.

% & Clear
Delete everything in the cell, or remove just the formatting contents,
comments or hvperlinks,

% 57 Sort & Filter
Organize your data so it’s easier to analyze.
You can sort the selected data from smallest to largest. largest to smallest,
or filter out specific values.

o HI Find & Select
Click to see options for finding text in your document.

You can use advanced search ﬂptmns to rep}ace text, Jump right (o a
specific spot, or pick other ways =~ ~———--------—'

Special Discount
For Only
Career Jyoti Students

EXCEL : INSERT TAB

¢ Pivot table

Easily arrange and summarize complex data in a PivotTable,

FYI: You can double-click a value to see which detailed values make up the
summarized total.

Tage Ly o el o = [ T eip L ymPLF
DY iy 7| 2 (w3 o TR N WG]
Eolble P e Talle | Hirmbom L gy | Feiead - i T e Gty Wid | Tw Thsdin | b | T | Sk
Fl Talder g r - *.“E" S
=L Add-Ari <1 (] i B Linky
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* Recommended PivotTable
Want us fo recommend PivoiTable that summarized your complex data?

Click this button to get a customized set of PivotTables that we think will best
suit your data.

e Table (Ctrl +T)
Create a table to organize & analyze related data.
Table make it easy to sort, filter, & format data within a sheet.

o [llustrations
¢ Picture

From file ,}Insert pictures from your computer or from other computers that
you'r connected to.

¢ Online Pictures
Find and insert pictures from a variety of online sources.
e Shapes
Insert ready-made shapes, such as circle, squares, and arrows.
¢ Insert a SmartArt Graphic
Insert a SmartArt graphic to visually communicate information.

SmartArt graphics range from graphical lists and process diagrams to more
complex graphics, such as Venn diagrams and organization charts.

¢ Take a Screenshot

Quickly add a snapshot of any window that’s open on your desktop to your
document.

e Charts
Recommended Charts
Want us to recommend a good chart to showcase your data.

Select data in your worksheet and click this button to get a customized set of
charts that we think will fit best with vour data.
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¢ Insert Column Chart
Use this chart type te visually compare values across a few categories,

Click the arrow to see the different types of column charts available and pause
the pointer on the icons to see a preview in your document.

e Insert Line Chart

Use this chart to show trends over time (years, months, and days) or
categories.

Click the arrow to see the different types of line charts available and pause the
pointer on the icons to see preview in your document.

¢ [Insert Pie or Doughnut Chart

Use this chart type to show proportions of a whole. Use it when the total of
your number is 100%.

Click the arrow to see the different types of pie and doughnut charts available
and pause the pointer on the icons to see a preview in your document.

¢ [Insert Bar Chart

Use this chart type to visually compare values across a few categories when
the chart shows duration or the category text is long.

Click the arrow to see the different types of bar charts available and pause the
pointer on the icons to see a preview in your document,

¢ [Insert Area Chart

Use this chart type to show trends over time (vears, months, and days) or
categories. Use to highlight the magnitude of change over time.

Click the arrows to see the different types of area charts available and pause
the pointer on the icons to see a preview on your document.

Insert Scatter (X, Y) or Bubble Chart

Use this chart type to show the relationship between sets of values.
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Click the arrow to see the different types of scatter and bubble charts
available and pause the pointer on the icons fo see a preview in your
document.

e [nsert Stock, Surface or Radar Chart

Click the arrow to see the different types of stock, surface, or radar charts
available and pause the pointer on the icons to see a preview in your
document.

¢ Insert Combo Chart

Use this chart type to highlight different types of information. Use it when the
range of values in the chart varies widely or you have mixed types of data.

Click the arrows to see pre-set combo charts and pause over the icons to see a
preview in your document. Click Create Custom Combo Chart to choose
different chart types to combine.

¢ PivotChart

Use PivotChart to graphically summarize data and explore complicated data.
* Power View

Insert a Power View Report

Make better business decisions and create beautiful, interactive reports.
¢ Line Sparkline

Sparklines are mini charts placed in single cells, each representing a row of
data in your selection.

¢ Column Sparkline

Sparklines are mini charts placed in single cells, each representing a row of
data in vour selection.

¢« Win/Lose

Sparklines are mini charts placed in single cells, each representing a row of
data in your selection.

e Slicer

MS. OFFICE PDF NOTES FOR CJE STUDENTS ONLY....
JOIN ADV. TALLY PRIME COURSE JUST ONLY RS. 8000/- Rs. 6000 /-




Career Jyoti Education Computer & Typing Institute

Use a slicer to filter data visually.

Slicer make it faster and easier to filter Tables, PivotTables, PivotCharts, and
cube functions.

* Timeline
Use a Timeline to filter dates interactively.

Timelines make it faster and easier to select time periods in order to filter
PivotTables, PivotCharts, and cube functions.

Links - Hyperlink
Add a Hyperlink (Ctrl + k)
Create a link in your document for quick access to webpages and files.

Hyperlinks can also take vou to place in your document.

* Text Box
Draw a text box anywhere.
e Header & Footer

The content of the header and footer repeats at the top and bottom of each
printed page.

This is useful for showcasing info, such file name, date and time.
e [nsert WordArt

Add some artistic flair to your document using a WordArt text box.
* Add a Signature Line

Insert a signature line that specifies the individual who must sign.

Inserting a digital signature requires that youn obtain a digital ID, such as one
from a cerfified Microsoft partner.

¢ Object

Embedded objects are documents or other files yon have inserted into this
document. Instead of having separate files, sometimes it’s easier to keep hem
all embedded in a document.
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¢ Insert Equation

Add common mathematical equations to your document, such as the area of a
circle or the quadratic formula.

You can also build your own equations using he library of math symbols and
structures.

¢ Symbol
Add symbols that are not on your keyboard.

Choose from a variety of options including mathematical, currency, and
copyright symbols.

Client Servicing Manager (Excellent

Communication & Advance.., : J o I N

Team MR GSA PVT LTD
Malad, Mumbai, Maharashtrz

&) 30,000 - ¥35,000 a month &= Full-time ADVI EXCEL

@ Morning shift +1

& Apply securely with Indeed Resume 0" L I PA I

2 Hiring multiple candidates

¢ Good with mail dralting advance excel Viookup, Hlgokup, 3999 ’. o N LY
Plvot Ere.

e Excellent Communication with advance Excel Expedence.
o Client Servicing: 3 years (Freferrec),

Active 22 daye ago - More_

[EXCEL PAGE LAYOUT --

% Themes

‘ ;'i.ﬂ Themes: pick a new theme to give your document instant
[ty

Style and just the right personality,

L) Tz i e il Wiy wade ) Lol

st ™ Ly FrE Wi aummac ¢ Eediee Hedocg {3 i
A x Clat 8 @& : = B &
. |=|fn'.l..' B e oy H 21 Faght AathemE s - '-‘,|'l'm ] W « ok
| s = Usrmrs Lestmen oz Pree Hackgraune Fort ek t iy Jir] e bangd - befectan Slgn
- m Ity = . » . figa T & | e 10 5, P R L A | Mne Fansard * Bezowail=  Fins
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Each theme uses a unique set of colors, fonts and effects to create a
consistent look and feel.

L/ Colors: quickly change all the colors used in your document by
picking a different color palette.

This will update the colors available to you in the color picker along
with any theme colors in your document. No matter what palette you
choose, your document will look perfectly coordinated.

|~ Fonts: heading: Calibri light
Body: Calibri
Quickly change the text in your document by picking a new font set.
This is an easy way to change all of your text at once. For this to work,
vour fext must be formatted using the *body” and ‘heading’ fonts.
Effects: quickly change the general look of objects in your
documents.
Each option uses various borders and visual effects, such as shading
and shadow, to give your objects a different look.
< Page Setup
—1 Adjust Margins: Set the margin size for the entire document of the
—1l current section.
Choose from several commonly-used margin formats, or customized
yOur owi.
‘|"_:T!+- Change Page Orientation: Give your pages a portrait or landscape
' layout.

——
N

Choose Page Size: Choose a paper size of your document.
_E._a Print Area: Select an area on the sheet you'd like to print.

. Breaks: Add a break where you want the next page to being in the
printed copy.

Your page break will be inserted above and to the left of your selection.

-y Background: Choose a picture for your background, and add some

Zo personality to vour worksheet,
€% Print Titles: Choose rows and columns you'd like to repeat on each
printed page, such as those with labels or headers.
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% Scale to Fit

—

¢as Wvidth: Shrink the Width of your printout to fit a certain number of pages.

s
.i__[l Height: Shrink the Height of your printout to fit a certain number of pages.
f,ﬂ Scale: Stretch or shrink your printout to a percentage of 1ts actual size.

Set width and height to Automatic when using this feature.

%+ Sheet Option
o Gﬂlﬂlﬂlﬂ
v vizw  View Gridlines: Show the lines between rows and columns to
make the sheet easier to read.

The gridlines won't print unless Print is also checked.

pint  Print Gridlines: Print the lines between rows and columns to
make the sheet easier to read.
o Heading

Vi Yiew Heading: Show column heading and row numbers. Columns

headings are the letters or numbers that appear above the columns on the
sheet.

Pt print Heading: Print row and column headings.
Row headings are the row numbers to the side of the sheet.

Column headings are the letters or numbers that appear above the
columns on a sheet.

% Arrange

Bring Forward: Bring he selected object forward one level so that
it’s hidden behind fewer objects.
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] Send Backward: Send the selected object back one level so that it's
hidden behind more objects.

[ Display the Selection Pane: See a list of all you objects.

This makes it easier to select objects, change their order, or change
their visibility.
Align Object: Change the placement of vour selected objects on the
page.
This is a great for aligning objects to the margins or the edge of the
page. You can also align them relative to one another.

Group Objects: Join object together to move and format them as if they
were a single object.

Rotate Objects: Rotate or flip the selected object.

1) Computer Windows 6 ) Tally Prime

2)Ms - Paint 7)Tally GST

3 ) Note Pad 8 ) Internet

4 ) Word Pad 9 ) Sniping Tool

5)Ms- Excel 2013 10 ) Scanning & Printing
—— — S

@WW @M\‘

Offer Valid Only Limited Seats Join Now !! Hurry Up !!
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[EXCEL REVIEW TAB -

Fike Home nEen Foge Leyout Formulim Cotn Rexiew Wi Developo Hzip LightPDF r-.:i' Tedl e what you want to do
= - - — F - = T 1]
ERErEFClE e : ' B & &
3 A She All Commeants .
ﬁl:ﬂﬂg Thesatrs ezl St Tanat= e : | Pretect Protec Allgws Dl
Acceszibifty  Lookup Camrrend Seeet Warkbook  Hange
Froofing hocertihifity  Inoghtr | Lenguiage Crmments Profect

** Proofing

ABC
Spelling (F7): Typos? Not on our watch. Let us check your spelling.

1 .
1 Research (Alt+Click): Want to explore something further? Use resources,

such as dictionaries, encyclopedias and translation services to get the info you
need.

L—I Thesaurus (Shift+F7): At a loss for words? Let us suggest another way to
say what you mean.

** Language

3
d

i Translate: Translate text into a different language by using bilingual
dictionaries and online services.

oy
Language: Choose the language for proofing tools such as spelling check.

You can also set other language preferences, including editing, display. Help and
ScreenTips languages.

+* Comments

New comment: Add a note about this part of the document.

x
— Delete: Delete the selected comment. Click the arrow from more options.
such as deleting all comments in the presentation or just the ones on this slide.
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e
- Previous: Jump to the previous comment.

i
Next comment: Jump to the next comment.

2 Show/ Hide Comment: Show or Hide the comment on the active cell.

i Show All Comments: Display all comments in the sheet.

" Show Ink: Show or Hide ink on the sheet.

%+ Changes

[_ Protect Sheet: Prevent unwanted changes from others by limiting their

< ability to edit.
For example, you can prevent people from editing locked cell or making
formatting changes.

== workbook, such as moving, deleting or adding sheets.

Share Workbook: Share vour workbook so that others can work in it at

' the same time.
FYI: Workbooks containing tables can’t be shared.

‘sa Protect and Share Workbooks: Share the workbook and protect change
tracking with a password.

:‘] Allow Users to Edit Range: Set up password protection on ranges, and

choose people who can edit those ranges.
Once set up, click Protect Sheet to activate the password-protected ranges.
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Fb.‘ Track Changes: Keep track of changes made to this document.
# This is especially useful if the document is almost done, and you're
working with others to make revisions or give feedback.

Gover tR EEI? o
Aiment Kec. Certificate With Google Verificati
@™ Provide 100% Quality Educat?nn o
sl 100% Learning Guarantee
@@= Students Ready For Jobs
wll™ 80% Practical & 20% Theory Lecture
@ 100% Job Oriented Course

| Tally Prime_ | Typing

1 9699417174 | 8180981064

Fuiie il Fatige Luawtiigl s i il [§F1E] Tia'Ein ik il il POF "-;:-' Tl pie wbiil gou vl il
e = [T F _ ~ =7 o Ao e —— p—
ity | =5 I e [ Y .ﬁ.|| — | q o aahl = {
= = L Ry | ety L R T} L1 7= =l . =]
ragth In':qa Hreak fage L brtom :'] Gl = Feading: doom 18R daam fa Pdgrem hmsrge Fiesm warkeh Wiamos
Prodms  Lavmut Viswn | selzctior  Window Ml Pare- ' Wirycka g = '
WL ok Wiew 5 LA Towan T [ T
F - el
5 View
Marrial
. Normal view = see vour document in normal view.
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Paga Break
o freiea Page break preview = see where the page breaks will

appear when your document is printed
[

. Page lavout view = see how vour printed document will
look. This is a good way to check out where pages begin and end,
and to see any headers/footers on the page

0

° Custom view = save your current display and print settings

as a custom view that you can quickly apply in the future.

e Show
Ruler | Formula Bar

| Gndlines |+ Headings

® Ruler = Show rulers next to your document. You can see and set
tab stops, move table borders, and line up objects in the
document. Also, you can measure stuff.

o (ridlines = show the lines between rows and columns in the sheet
to make the sheet easier to read.

® Formula bar = show the formula bar so you can see formulas in
cells.

® Headings = show columns headings and row numbers. Column
heading are the letters or numbers that appear above the columns
on the sheet,

= Joom

Q

_..
LLILIT]

" Zoom to the level that’s right for you, for zoomier zooming,
use the controls in the status bar.
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.-r
—m
+ 1] Zoom your document to 100%

» i Zoom the sheet so the selected range of cells fills the entire
window. This can help you focus on a specific area of the sheet.
* Windows
e New Windows
Open a second window for your document so you can work in
different places at the same time.

e Arrange all
Stock your open windows so vou can see all of them at once.

¢ Freeze panes

Freeze a portion of the sheet to keep it visible while you scroll
through the rest of the sheet. This is useful for checking out data
in other parts of your worksheet without losing your headers or
labels.

. .E.Splii = divide the window into different panes that each
scroll separately.

—

e " Hide = hide the current window. To bring the window
back, click the unhide button.
o

¢  Unhide Windows = Unhide any windows hidden by the
hide window feature.

o || View side by side = Instead of switching back and forth
between workbook, view them easier.

o 'Synchronous scrolling =scroll two documents at the same
time. This is a great way to compare documents line or scan
for differences. To use this feature, turn on view side by side.
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o | |Reset windows position = place the documents you're
comparing side by side so they share the screen equally. To

use this feature, turn on view side by side.
e

-

Stz
Jndes:” Switch windows = quickly switch to another open
excel windows.

* Macros
| I1-1ac=r::.a
e |-  See a list of macros you can work with view macros
[Alt+18]
Click to views, record or pause a macro.

¢ View macros = [alt+18] see list of macros you can work with.

* Record macro = each of the commands you perform will be
saved into the macro so that you can play them back again.

e Use relative references = use relative references so that
macros are recorded with actions relative to the initial selected
cell. For instance, if record a macros in cell A1 which move the
cursor to A3 with this option turned on, running the resulting
macro in cell J6 would move the cursor to J8. If this option of
turned off when the macro was recorded, running it in cell j6
would move the cursor to AJ.
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Ctrl + N: To create a new workbook.

Ctrl + O: To open a saved workbook.

Ctri + S: To save a workbook,

. Ctrl + A: To select all the contents in a workbook

. Ctrl + B: To turn highlighted cells bold.

Ctrl + C: To copy cells that are highlighted.

Ctrl + D: To fill the selected cell with the content of the cell right above
Ctrl + F: To search for anything in a workbook

. Ctrl + G: To jump to a certain area with a single command

10. Ctrl + H: To find and replace cell contents.

11. Ctrl + |: To italicise cell contents
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12. Ctrl + K: To insert a hyperlink in a cell.

13. Ctrl + L: To open the create table dialog box.

14. Ctrl + P: To print a workbook.

15. Ctrl + R; To fill the selected cell with the content of the cell on the left.
16. Ctrl + U: To underiine highlighted cells.

17. Ctrl + V: To paste anything that was copied.

18. Ctrl + W: To close your current workbook.

19. Ctrl + Z: To undo the last action.

20. Ctrl + 1: To format the cell contents.

21. Ctrl + 5: To put a strikethrough in a cell.

22. Ctrl + 8: To show the outline symbols.

23. Ctrl +9: To hide a row.

24. Ctrl + 0: To hide a column.

235. Ctrl + Shift + :: To enter the current time in a cell.

26. Ctrl + :: To enter the current date in a cell.

27. Ctrl + " To change the view from displaying cell values to formulas.
28. Ctrl + *: To copy the formula from the cell above.

29. Ctrl + - To delete columns or rows.

30. Ctrl + Shift + = To insert columns and rows.

31. Ctrl + Shift + ~: To switch between displaying Excel formulas or their
values in cell.

32. Ctrl + Shift + @: To apply time formatting.

33. Ctrl + Shift + !: To apply comma formatting.

34. Ctrl + Shift + $: To apply currency formatting.

39. Ctrl + Shift + #: To apply date formatting.

36. Ctrl + Shift + %: To apply percentage formatting.

37. Ctrl + Shift + & To place borders around the selected cells.
38. Ctrl + Shift + - To remove a border.

39. Ctrl + - To delete a selected row or column.

40. Ctrl + Spacebar: To select an entire column.

41. Ctrl + Shift + Spacebar: To select an entire workbook.

42. Ctrl + Home: To redirect to cell A1.

43. Ctrl + Shift + Tab: To switch to the previous workbook.

44. Ctrl + Shift + F: To open the fonts menu under format cells.
45. Ctrl + Shift + O: To select the cells containing comments.
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46. Ctrl + Drag: To drag and copy a cell or to a duplicate worksheet.
47. Ctrl + Shift + Drag: To drag and insert copy.

48. Ctrl + Up arrow: To go to the top most cell in a current column.
49. Ctrl + Down arrow: To jump to the last cell in a current column.
50. Ctrl + Right arrow: To go to the last cell in a selected row.

51. Ctrl + Left arrow: To jump back to the first cell in a selected row.
52. Ctrl + End: To go to the last cell in a workbook.

53. Alt + Page down: To move the screen towards the right.

54. Alt + Page Up: To move the screen towards the left.

55. Ctrl + F2: To open the print preview window.

56. Ctrl + F1: To expand or collapse the ribbon.

27. Alt: To open the access keys.

58. Tab: Move lo the next cell.

39. Alt + F + T: To open the options.

60. Alt + Down arrow: To activate filters for cells.

61. F2: To edit a cell.

62. F3: To paste a cell name if the cells have been named.

63. Shift + F2: To add or edit a cell comment.

64. Alt + H + H: To select a fill colour.

65. Alt + H + B: To add a border.

66. Ctrl + 9: To hide the selected rows.

67. Ctrl + 0: To hide the selected columns.

68. Esc: To cancel an entry.

69. Enter: To complete the entry in a cell and move to the next one.
70. Shift + Right arrow: To extend the cell selection to the right.
71. Shift + Left arrow: To extend the cell selection to the left.

72. Shift + Space: To select the entire row.

73. Page upl/ down: To move the screen up or down.

74. Alt + H: To go to the Home tab in Ribbon,

75. Alt + N: To go fo the Insert tab in Ribbon.

76. Alt + P: To go to the Page Layout tab in Ribbon.

77. Alt + M: To go to the Formulas tab in Ribbon.

78. Alt + A: To go to the Data tab in Ribbon.

79. Alt + R: To go to the Review tab in Ribbon.

80. Alt + W: To go to the View tab in Ribbon.
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81. Alt + Y: To open the Help tab in Ribbon.

82. Alt + Q: To quickly jump to search

83. Alt + Enter: To start a new line in a current cell.

84. Shift + F3: To open the Insert function dialog box.
85. F9: To calculate workbooks.

86. Shift + F9: To calculate an active workbook.

87. Ctrl + Alt + F9: To force calculate all workbooks.
88. Ctrl + F3: To open the name manager.

89. Ctrl + Shift + F3: To create names from values in rows and columns.
90. Ctrl + Alt + +: To zoom in inside a workbook.

91. Ctrl + Alt +: To zoom out inside a workbook.

92. Alt + 1: To tum on Autosave.

93. Alt + 2: To save a workbook.

94. Alt + F + E: To export your workbook.

95. Alt + F + Z: To share your workbook

96. Alt + F + C: To close and save your workbook.

97. Alt or F11: To turn key tips on or off.

98. Alt+ Y + W: To know what's new in Microsoft Excel.
99. F1: To open Microsoft Excel help.

100. Ctrl + F4: To close Microsoft Excel.
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